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READ ME FIRST 

Welcome to Take Control of Customizing Leopard, version 1.1, 
published in March 2008, by TidBITS Publishing Inc.  

Every couple of years, Apple plunges its excited users into a new 
world with a major revision of Mac OS X. This time, it’s Leopard 
(Mac OS X 10.5). So, what’s new in Leopard? What’s all the fuss 
about? This book shows you, through a hands-on guided tour of the 
adjustments, tweaks, and customizations you can make in the System 
and the Finder. This book was written by Matt Neuburg and edited 
by Tonya Engst. 

Copyright © 2008, Matt Neuburg. All rights reserved. 

The price of this ebook is $10. If you want to share it with a friend, 
please do so as you would a physical book. Click here to give your 
friend a discount coupon. Discounted classroom copies are also 
available. 

Updates 
We may offer free minor updates to this book. To read new infor-
mation or find out about any new versions of this book’s PDF, click 
the Check for Updates link on the cover. On the resulting Web page, 
you can also sign up to be notified about updates to the PDF via 
email. If you own only the print version of the book, contact us at  
tc-comments@tidbits.com to obtain the ebook. 

Basics 
In reading this book, you may get stuck if you don’t know certain 
basic facts or if you don’t understand Take Control syntax for things 
like working with menus or finding items in the Finder. Please note 
the following: 

• Path syntax: I occasionally use a path to show the location of a 
file or folder in your file system. Path text is formatted in bold type. 
For example, Leopard stores most utilities, such as Disk Utility, in 
the Utilities folder; the path to Disk Utility is /Applications/ 
Utilities/Disk Utility. 

The slash at the start of the path tells you to start from the root 
(top) level of the disk. You will also encounter paths that begin 
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with ~ (tilde), which is a shortcut for any user’s home directory. 
For example, if a person with the user name joe wants to install  

fonts that only he can access, he would install them in his 
~/Library/Fonts folder, which is just another way of writing 
/Users/joe/Library/Fonts. 

• Menus: When I describe choosing a command from a menu in 
the menu bar, I use an abbreviated description. For example, the 
abbreviated description for the menu command that creates a new 
default window in the Finder is “File > New Finder Window.”  

• Preferences: When I say “preference pane,” especially when 
I speak of “the so-and-so preference pane,” I’m referring to the 
System Preferences application. To start System Preferences, 
choose System Preferences from the  menu (or click its icon 
in the Dock, if it’s there). You access a particular preference pane 
by way of its icon, or the View menu. For example, to see “the 
Displays preference pane,” you would launch System Preferences 
and then click the Displays icon or choose View > Displays. 

On the other hand, talk of preferences in relation to a particular 
application has to do with the window you see when you choose 
AppName > Preferences (where AppName is the name of the 
application). So, for example, when I say, “set Terminal to emulate 
a vt100 or vt102 in its preference window,” I’m telling you to start 
Terminal, and then choose Terminal > Preferences and do some-
thing in the window that appears. 

• Panes and views: Window content in Mac OS X can be dynamic. 
What’s in a window can change depending on what button you 
press. So there needs to be terminology describing the changeable 
portion of a window. I call the highest region of changeability in a 
window (often the entire content of the window) a “pane”; smaller 
areas within a pane that can change, I call a “view”. 

For example, as I just mentioned, when you start System Prefer-
ences, you can then click an icon or choose from the View menu to 
see a particular preference pane, such as Displays or Energy Saver. 
Those, then, are panes. Similarly, in the Finder preferences win-
dow, you can click a toolbar item, such as General or Labels, to 
change the entire content of the window; so I’ll speak of “the 
General pane” or “the Labels pane.” 
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Smaller regions whose content changes when you click a button—
the sort of area that often used to be called “tabs”—are what I call 
“views” in this book. So, for example, to see “the Color view of the 
Displays preference pane,” you would launch System Preferences 
and then click the Displays icon to switch to the Displays pane, and 
then click Color to see the Color view within the Displays pane. 

What’s New in This Version 
Version 1.1 of Take Control of Customizing Leopard contains a 
number of changes from the original 1.0 release. Some of these 
changes are responses to Apple’s release of the 10.5.2 update to 
Leopard, a major update which fixed many bugs and responded to 
user feedback, considerably altering certain aspects of the Leopard 
landscape. Other changes reflect discoveries subsequent to the 1.0 
release, as well as the occasional accidental omission. The most 
significant differences are these:  

• The 10.5.2 Leopard update introduced a preference for toggling 
menu bar transparency, and provided alternative Dock stack 
behavior. Both are now covered in the renamed and expanded 
section, Dominate the Dock, Master the Menu Bar (p. 28).  

The same section now also describes how to eliminate the Dock’s 
“reflective shelf” look when positioned at the bottom of the screen.  

• The 10.5.2 Leopard update introduced a status menu for Time 
Machine. To take account of this status menu, changes were made 
to the Preserve the Past with Time Machine (p. 16) section, as well 
as to Dominate the Dock, Master the Menu Bar (p. 28), and, of 
course, Customize Status Menus (p. 127). 

• Some new pearls of wisdom were added to Preserve the Past with 
Time Machine (p. 16) and to Set Up Spaces (p. 78). 

• A note (top of p. 73) was added to Set Up Exposé, because certain 
details might work differently if you have an Aluminum keyboard. 

• A new subsection, Block Automatic Updates (p. 134), was added to 
Perform Miscellaneous Configurations. 

 Take Note! This version (1.1) of this book assumes you are using 
Leopard 10.5.2 or later. 
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INTRODUCTION 
Perhaps on the evening of October 26, 2007, you stood in line to 
obtain one of the first copies of Mac OS X version 10.5 Leopard at 
your local computer store. Or perhaps you were more cautious and 
waited until you felt Apple had straightened out the initial kinks 
inevitable in a new operating system release. One way or another, 
you wound up with a copy of Leopard.  

You stayed up late installing it on your Mac; then you fell asleep 
exhausted. You woke up the next morning excited as a child on 
Christmas. You rushed to the computer and started it up. You gaped 
at its new, improved startup speed—even faster than Tiger, and with 
no “thermometer” dialog! You gasped with amazement at the trans-
parent menu bar! You shivered at the icy look of the shiny, new, 
reflective Dock! You squealed with delight as you tried the new Search 
field in Safari! You gawked as you read a TextEdit document directly 
from the Finder, without opening TextEdit, using Quick Look! You 
drooled as you played with the Finder’s new Cover Flow view! 

Now it’s the second day. You’re finished playing (and tired of all those 
exclamation marks), and you want to get back to work. You’d like 
to Take Control. And, in particular, you’d like to take control of how 
your computer looks and behaves. But where to start? What needs 
customization, so that things will go smoothly henceforward? 

This book covers these second-day-of-Leopard sorts of things. It 
introduces you to Leopard by showing ways you can customize your 
computer—ways that were impossible in previous versions of Mac 
OS X, or that might not be obvious from a casual inspection, or that 
experience has shown to be worthy of your attention.  

Whether you’ve upgraded from Tiger or switched from Windows, 
whether you’re new to Leopard or you just want to understand it 
better, this book is your guide to what you can and should customize 
in Leopard to get the most out of it. I’m not writing for Unix experts, 
so I don’t talk about clever technical hacks; the customizations pointed 
out here are those that Leopard wants and expects you to perform 
directly in its normal interface. I do, however, point out areas where 
Leopard might need a little help from third-party utilities in order for 
you to work most comfortably and efficiently. 

Now let’s meet Leopard and make it change its spots! 
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CUSTOMIZING LEOPARD QUICK START 

This book describes many customizations, not all of which you 
need to employ, and some of which will be more important to you 
than others. Naturally, I think that sooner or later you should take 
the time to read this book from start to finish, but I also understand 
that you’re eager to get working with Leopard and that you live a busy 
life, and that you might want to know what’s most important to do 
right now, and come back to the rest of the book later. So, I suggest 
a three-stage approach: 

1. Right away, perform the customizations that will immediately 
improve your Desktop and interface experience. 

2. Learn about the major new technologies and customizations in 
Leopard, so that you can get the most out of those technologies 
in your work. 

3. Catch up on the remaining customizations whenever you have 
time. This makes sense especially for customizations where you 
can’t know what you want to do until you see over time what your 
own needs and habits are. 

Here, then, is how I suggest you customize and learn about Leopard 
with the help of this book: 

Do these things right away: 
• If you were already using Tiger and would like to prepare yourself 

to change your work habits to fit the new Leopard environment, 
read Know What’s New (p. 8). 

• Check that you installed Leopard correctly, in accordance with 
what you want it to do for you; read Install Intelligently (p. 11). 

• Set up your overall workspace; read Dominate the Dock, Master 
the Menu Bar (p. 28) and Straighten Out Your System Preferences 
(p. 33). 

• Customize your Finder windows so you can navigate easily to 
important areas of your disks; read Handle the Hierarchy (p. 35) 
(and possibly Appendix A: Use AppleScript to Make Every Window 
Open in List View, No Matter What, p. 137). 
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• Make the pointer—Apple calls it the cursor in this context—easier 
to see, the screen easier to read, and generally clear the decks 
so you have a good view of what you’re doing; read Ease Your 
Eyeballs (p. 105). 

Learn more about Leopard: 
• Make your computer safer and studlier, thanks to Time Machine, 

a new Leopard feature that makes backups easy as pie; read 
Preserve the Past with Time Machine (p. 16). 

• Discover Spaces, a new Leopard feature for helping you deal 
with window overload. Also, explore and configure Exposé and 
Dashboard. Read Wash Your Windows (p. 72). 

• Simplify your font access and make Leopard run leaner and 
meaner; read Fix Your Fonts (p. 113). 

• Know about Unicode and how to type special characters and 
symbols in Mac OS X; read Tackle Your Text (p. 120). 

Do these things as needed and when time permits: 
• Tweak keyboard shortcuts and keyboard behavior to match your 

needs and habits; read Control the Keyboard, Master the Mouse 
(p. 91). 

• Make effective use of the icons at the right end of your menu bar; 
read Customize Status Menus (p. 127). 

• Make various additional small customizations; read Perform 
Miscellaneous Configurations (p. 130). 

• Be ready to continue exploring customizations; read Find Other 
Customizations (p. 136). 
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KNOW WHAT’S NEW 

If you’re familiar with Mac OS X 10.4 Tiger, Leopard presents 
interesting changes that you may want to take account of as you 
adjust your work habits to fit the new environment. Not all of these 
involve customization, so they don’t fit into the overall theme of this 
book. But in order for you, a habituated Tiger user, to work with 
Leopard effectively, you may have to customize yourself! Here are 
some of the biggest Leopard changes that may demand a change in 
your mental orientation (with reference, where appropriate, to later 
sections of this book): 

• The menu bar, the Dock, and windows in general all have a new 
look. This is largely cosmetic, but it might affect your work habits. 
For example, the menu bar is now optionally transparent, so 
Desktop pictures behind it can make it difficult to read. The Dock’s 
new look is bold and shiny, which I find distracting; the way an 
application’s icon in the Dock is marked to indicate that the appli-
cation is running is much less discernable than in the past; and a 
folder in the Dock, now called a stack, has a new behavior that I 
find objectionable. To me, and perhaps to you also, using Leopard 
absolutely requires learning about these changes and customizing 
your Mac so that you can best deal with them (see Dominate the 
Dock, Master the Menu Bar, p. 28). 

• Downloads are no longer directed by default to the Desktop; 
instead, they go to a new Downloads folder in your Home direc-
tory. This will help keep the Desktop clutter-free, which is a good 
thing (see Set Up the Desktop, p. 47). 

• A pervasive feature of Leopard, mostly in the Finder but with 
implications for elsewhere, is Quick Look, which displays a large 
full-length preview of a file’s contents without actually opening 
the document in its associated program. To display the Quick Look 
view of an item or multiple items selected in the Finder, press 
Space or Command-Y (or click the  button in the Finder 
window’s toolbar).  

Experiment with Quick Look, as it may have value for exploring 
files you are thinking of opening, for playing sound files, and for 
displaying pictures; Quick Look replaces the Tiger “Slideshow” 
feature of the Finder (see Quick Look, p. 42). 
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INSTALL INTELLIGENTLY 

If you’ve already installed Leopard, it may seem too late to speak of 
customizing the installation. Nevertheless, customization of Leopard 
does begin with installation. When you originally run the installer, 
you pass through a series of several screens leading to the actual 
installation: 

1. The language screen 

2. The Welcome screen 

3. The License Agreement screen 

4. The Select a Destination screen 

5. The Install Summary screen 

The last two screens, Select a Destination and Install Summary, are 
places where you can perform important customizations. 

  
DON’T 
PANIC 

You don’t have to reinstall if you missed performing customi-
zations in Select a Destination and Install Summary. You can 
if you want to, though; it isn’t difficult, and nothing will be lost 
(unless you choose Erase and Install). In any case, regardless 
of how you installed, you probably have a working installation 
of Leopard, and that’s the important thing. If you omitted 
installing a system component listed in the Install Summary 
screen, such as the drivers for a new printer, you can install it 
later by double-clicking the file Optional Installs.mpkg; it’s 
inside the Optional Installs folder. 

  

Select a Destination 
The Select a Destination screen contains an Options button. Click it 
to determine whether this installation will be an Erase and Install, an 
Archive and Install, or a simple Install (or this third option might be 
called Upgrade Mac OS X).  

Erase and Install does precisely what it says: it erases everything 
on the volume it installs to, so that afterwards the only thing on that 
volume is the newly installed clean Leopard system (including the 
single admin user that you create when the computer restarts after 
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PRESERVE THE PAST WITH TIME MACHINE 

Leopard includes, for the first time in the history of the Macintosh, 
a built-in method of backing up your computer’s data and restoring 
past versions of your files with ease and transparency. This is the 
appropriately named Time Machine, a simple device for making sure 
you can recover the past when you need to. 

Time Machine requires that you have a spare volume to back up 
to. This can be a partition on (or the whole of) either a secondary 
internal hard disk or an external disk. You cannot use Time Machine 
to back up the volume that is receiving your backups. So plan 
accordingly. 

  
NOTE TAKE CONTROL OF TIME MACHINE 

When you first install Leopard, once the computer restarts 
and you are booted from the newly installed system, you 
may see a dialog asking you whether to enable Time Machine 
automatically.  

 
I recommend that you decline this offer; rather than letting 
Time Machine decide on its own settings and start working, 
you should customize and configure Time Machine manually 
as described here. 
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DOMINATE THE DOCK, MASTER THE MENU BAR 

The Dock and the menu bar are effectively always present, overlaying 
your entire experience of Leopard. Adjusting them to your taste is 
therefore crucial. 

The Dock 
The Dock is one of the most controversial elements of the Mac OS X 
interface. Some users feel they couldn’t manage without it; others find 
it poorly implemented and misconceived. In Leopard, furthermore, 
the Dock has a new look: when it is located at the bottom of the 
screen, it is “painted” as a highly reflective “shelf,” and its icons sit 
higher on that shelf than they sat on the Dock background of earlier 
Mac OS X systems. The Dock is thus more noticeable (some might say 
“distracting”) and occupies more room than it previously did. 

Nothing is so annoying as using a computer whose Dock is in your 
way, or in some other sense isn’t how you want it. You can customize 
the Dock’s position, size, and behavior to some extent, and you can’t 
comfortably get any other work done until you do; so it makes sense 
to take a moment, early on, to set up the Dock according to your 
tastes (which is why this section appears so early in this book). 

Customize the contents 
Apple front-loads the Dock with icons for some commonly used 
applications, but you can change Apple’s defaults. 

• To remove an icon, drag it out of the Dock, or choose Remove 
from Dock from that icon’s Dock menu (Control-click, or right-
click, a Dock icon, or hold the mouse down on the icon for a while, 
to access its menu).  

If, like me, you’re going to use a third-party launcher, you might 
like the Dock to consist of nothing but running applications; thus, 
one of my first moves after installing Mac OS X is to remove all 
application icons from the Dock, using the Dock solely as a way 
to access applications that are already running. 

But I recommend that you leave the Spaces icon in place for now, 
until you’ve decided on a means for activating Spaces (as I discuss 
later, under Set Up Spaces). 
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STRAIGHTEN OUT YOUR SYSTEM PREFERENCES 

The vast majority of Leopard customizations are performed through 
the System Preferences application. Therefore, one of the first things 
to customize after you’ve installed and started up Leopard for the first 
time is System Preferences itself.  

The default arrangement of preference pane icons in System 
Preferences’ window is by category (Personal, Hardware, Internet & 
Network, and System). Perhaps this arrangement is to your taste, but 
it certainly isn’t to mine, because I can never find anything! I like to 
see these icons in straightforward alphabetical order, by the name of 
the preference pane. To obtain that arrangement (Figure 6), start up 
System Preferences and choose View > Organize Alphabetically. 

FIGURE 6 

 
 

System Preferences, in the possibly more convenient alphabetical 
arrangement.  

  
Incidentally, another way to navigate to a desired System Preferences 
pane is through the View menu, which also lists the panes in alpha-
betical order. Plus, when System Preferences is running, the same 
menu appears when you click and hold on its Dock icon. 
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HANDLE THE HIERARCHY 

Your hard disk is full of things, such as applications you want to use, 
or documents you want to read or edit. They live somewhere on your 
hard disk—but where? To get anything done at all, you must be able 
to locate your files. The better you understand how to locate files, and 
the more you customize that process to suit your own preferences and 
needs, the more comfortable and productive you’ll be. 

There are two main ways of locating files on your computer, which 
you can think of as polar opposites of one another: 

• The folder hierarchy: Every file is in a folder, every folder is 
in a folder, and so on, upward, until we reach the top level, called 
a volume: this is usually your hard disk, or a partition of your hard 
disk. So, to reach any file or folder, you can traverse that same path 
downward: starting at some high level, such a volume or your 
Home folder, you enter a folder, then a folder within that, and 
so forth, until you reach whatever you’re after. 

• Jumping: Navigating the folder hierarchy can be pretty tedious, 
and besides, the hierarchy itself is a pretty terrible mode of organi-
zation; it’s organized like a filing cabinet, but your mind isn’t, and 
to locate something this way, you must know beforehand the entire 
sequence of folders containing it, which is not always the case. You 
need ways to slice through the hierarchy and reach your stuff, no 
matter where it is. You want to jump directly to the file or folder 
you have in mind—so let’s call this way of locating things jumping.  

You can customize your Leopard environment—in particular, the 
Finder and Spotlight, as well as your Open and Save dialogs—so that 
you can both navigate the hierarchy and jump directly to your stuff, 
comfortably and easily. In this section, I explain how.  

Set Up the Default Finder Window 
Your first concern is to customize the size, position, and style of your 
Finder windows—in particular, your default Finder window. This is 
the window that you summon in the Finder by choosing File > New 
Finder Window (Command-N).  
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WASH YOUR WINDOWS 

Here’s a news flash from the Department of Unintended Conse-
quences: windows are great, but they’re also a problem. As soon as 
you have more than a few windows open at once, it’s clear that those 
windows are like automobiles, and your monitor is like a Los Angeles 
freeway—it’s overcrowded, and no matter how much you widen it, 
it’s still going to be overcrowded. This is particularly a problem on 
an operating system like Mac OS X, where the windows of different 
applications can become intermingled with one another. Finding 
the window you want can be like searching, amid the distracting 
red herrings, for the Purloined Letter: you might not be able to 
see it even if it’s in plain sight. 

To ease the window traffic on your monitor, Apple has provided 
various devices for helping you see the windows you want to see. 
In 2003, in Panther, Apple introduced Exposé as a way of letting 
you switch quickly among all your open windows (or get them all 
out of the way so you can see your Desktop). Now Leopard introduces 
Spaces, a true virtual desktops implementation that lets you switch 
between entire sets of windows at once. Your task is to decide 
whether you went to use either or both of these, and to customize 
them with triggers so that you’ll use them readily. 

Also in this category we will consider Dashboard, which qualifies as 
a form of window management because it presents certain miniature 
applications in a special window layer that’s visible only when you 
want to use it. Finally, if all that isn’t enough, a third-party applica-
tion might make windows work in a more satisfactory way for you. 

Set Up Exposé 
Let’s start with Exposé, and in particular with an overview of how 
to use each of Exposé’s three modes: All Windows, Application 
Windows, and Desktop. Once you understand these three modes, 
you’ll be ready to customize Exposé so that you can summon those 
modes whenever you like. I assume that you have not yet customized 
Exposé; the keyboard shortcuts I start with (and which you might 
want to customize) are the Leopard defaults. 

This is a free sample of “Take Control of Customizing Leopard.”
Click here to buy the full 143-page ebook for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU35934156216&PT=TRK-0047-SAMPLE


Page 91 

CONTROL THE KEYBOARD, MASTER THE MOUSE 

Advanced as it is, Leopard can’t read your mind. So, with the possible 
exception of some valiant pioneers who are making use of speech 
recognition or other innovations, the main way to get anything done 
on your Mac is still by pressing keys and manipulating the mouse. 
Therefore you owe it to yourself to give a little thought to what the 
keyboard and the mouse do. You can make a number of customiza-
tions regarding how the computer responds to your keypresses and 
mouse clicks. Individually, each of these customizations may seem 
small, but considering how much time you’ll spend mousing and 
typing, they can add up to the difference between annoyance (or 
even wrist pain) and nimbleness. 

Modify Your Modifiers 
The modifier keys are Shift, Control, Option, Command, and Caps 
Lock. Some users don’t like the placement of these keys; perhaps 
they are accustomed to a different layout. Leopard lets you change 
their placement (except for that of the Shift key, which is always 
the Shift key). To make such a change, go to the Keyboard view 
of the Keyboard & Mouse preference pane, and click the Modifier 
Keys button. 

This might seem rather an arcane setting; but it can be practical. 
Consider, for example, the Caps Lock key. It’s an anachronistic 
holdover from the typewriter era. Doesn’t it drive you crazy? Don’t 
you sometimes accidentally turn on Caps Lock, and then your 
passwords don’t work or you’re suddenly typing capital letters by 
mistake? Don’t you just wish you could rip it off the keyboard? 

Well, you can: In the Caps Lock Key pop-up menu, choose No Action. 
Presto, the Caps Lock key is completely disabled. Alternatively, you 
can re-map the Caps Lock key so that it acts as some other modifier 
key; you might, for example, make it into an extra Control key.  

You can use this feature to swap modifier key functionality in other 
ways. (You can even rearrange modifier key functionality differently 
for different keyboards, if you have multiple keyboards.) But make 
sure you don’t leave yourself with no way to access important 
modifiers. For example, without the Option and Command modifiers, 
you can’t type certain characters or press most keyboard shortcuts. 
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EASE YOUR EYEBALLS 

A common complaint about using computers is an inability to see 
comfortably. You sit at the computer for long stretches of time; you 
read text on the screen; you peer at minute details. You deserve as 
pleasant a viewing experience as you can possibly get. Leopard gives 
you many ways to improve the way your monitor portrays the 
computer’s world. 

Calibrate Your Screen 
When you first install Leopard, the default screen calibration may 
give your screen a pale, washed-out appearance, making icons 
difficult to distinguish and text difficult to read. 

If you don’t like, or have doubts about, the way your screen looks, go 
to the Color view of the Displays system preference pane and pick a 
different display profile, if there is one. If that doesn’t help, you can 
calibrate the display manually. Follow these steps: 

1. Wait until a time of day, and be in a location and under lighting 
conditions, where you commonly use your computer. Your 
perception of the screen is greatly affected by the incident and 
ambient light. Position yourself where the screen is at its best 
viewing angle. Many screens give false colors or reduced visibility 
if seen from too high or low or from one side. 

2. In the Display view of the Displays preference pane (or using 
whatever physical control is supplied by your monitor), set the 
screen’s brightness to maximum. In the Seeing view of the 
Universal Access preference pane, set the contrast to normal 
(and if your monitor has a physical Contrast control, set it to 
maximum). 

3. It may be useful to have open some windows in the background 
that can serve as a reference point. I like to open TextEdit, because 
the background of an empty window works as a standard white 
point reference. Also, in Text Edit, I like to summon the Open 
dialog and display it in List view, because the blue and white 
stripes are quite indicative of how things are going (using the 
default calibration, I can’t see them at all, which shows just how 
poor it is). 
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FIX YOUR FONTS 

Font management has always been a problem on the Mac, and fonts 
remain an extraordinarily rocky area of Mac OS X. Once you have 
more than a few fonts, the mere act of choosing a font in an applica-
tion becomes a trial, because the list of available fonts is so long. Font 
versioning, especially when different fonts have the same name, is a 
troublesome business. And a surprisingly high percentage of crashes 
and other strange phenomena experienced by Mac OS X users are due 
to font problems, such as conflicts between fonts, or fonts that are in 
some way badly structured. 

It doesn’t help matters that, on Mac OS X, a wide variety of font types 
are acceptable. In addition to the old-style TrueType font suitcases, 
Mac OS X fonts can be TrueType data-fork files (.dfont), Windows 
TrueType (.ttf and .ttc), OpenType, and PostScript Type 1 and 
Multiple Master (LWFN and sfnt).  

At the same time, fonts that worked on previous systems may not 
work on Mac OS X. This could be because of their file format; for 
example, pure bitmap fonts are no longer supported. It could also be 
because of the font’s structure; for example, fonts that used to provide 
special characters such as symbols and non-English letters may not 
be compatible with Mac OS X’s Unicode underpinnings (see Tackle 
Your Text, later), and characters in those fonts can show up as blanks 
or boxes. And some fonts appear to be just plain buggy, or use 
features that Mac OS X doesn’t support. 

Then there’s the fact that even knowing what fonts are installed is 
no easy matter, because, unlike earlier systems with just one Fonts 
folder, in Mac OS X fonts are automatically loaded if they are in any 
of (at least) three places:  

• /System/Library/Fonts 

• /Library/Fonts 

• ~/Library/Fonts 

In short, fonts are a quagmire. Even worse, Apple provides 
insufficient end-user tools for dealing with them. For instance, there 
are still font suitcases, but Mac OS X gives you no way to open them, 
to modify them, or even to inspect which fonts are inside them. 
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TACKLE YOUR TEXT 

Once upon a time (and not so long ago), fonts and text characters 
were intimately connected; but now they are almost independent 
of one another. To see what I mean, consider “special characters,” 
by which I mean just about any character that an English-speaking 
user can’t type just by pressing a key under normal circumstances.  

Suppose, for example, you want to type a Greek character. Time was, 
you used to do that by switching fonts. For example, to type a Greek 
“alpha,” you might have switched to the Symbol font, or some special-
ized Greek font, and typed the A key.  

In Mac OS X, that doesn’t work. If typing the A key gives you an 
“a” in one font, it gives you an “a” in every font. So how do you access 
special characters in Mac OS X? You do it by switching keyboard 
layouts (and input methods).  

Keyboard layouts remap the keyboard, and they remap it regardless 
of what font you’re using. If you remap the keyboard and then use 
that remapping to enter a Greek “alpha” in whatever way the re-
mapping makes this possible, an “alpha” will be entered, regardless 
of what font you’re using. (In fact, an “alpha” will be entered even if 
the font you’re using doesn’t contain the “alpha” glyph! The rule is 
that provided some font contains the character, you can enter it; the 
system will automatically find the character in a font that contains 
it, even if that isn’t the font you’re using.)  

You change keyboard layouts with the Input menu. The Input menu 
is thus the primary locus for dealing with special characters; if you 
want to type any interesting characters, you need to know about the 
Input menu. That’s a customization: you have to make the Input 
menu appear, and you have to populate it with the keyboard layouts 
and input methods that you need. That’s what we’ll do now. 

Use the Input Menu 
Here’s how to enable and configure the Input menu: 

1. Open the International preference pane, and switch to the Input 
Menu view.  

2. At the bottom of the Input Menu view, check “Show input menu in 
menu bar.”  
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CUSTOMIZE STATUS MENUS 

Status menus (also called status items, status icons, menu extras, 
or menu bar extras) are the icons that appear at the right end of 
your menu bar. (This area is technically called the system status bar.) 
Status menus can be a convenience or a waste of valuable menu bar 
space, depending on your needs, your monitor size, and what you had 
for breakfast. In any case, controlling which status menus appear is 
a customization you can and should perform.  

Unfortunately, the tools for status menu management are scattered 
all over your computer. This section will try to help you find most 
of them, but finding all of them would be an impossible task. 

How do status menus come into being? There are two ways:  

• Some status menus are present by virtue of being enabled in a 
System Preferences pane through a checkbox that you can check 
or uncheck.  

• Some status menus are put there by some application, either 
through its preferences or because the application happens to 
be running. 

 

In the system status bar shown above, the first two status menus 
(starting from the left) come from third-party utilities—respectively, 
the preference pane PTHPasteboard and the application FastScripts. 
Then come status menus placed by various built-in System Preference 
panes—Universal Access, Spaces, Network (AirPort), Sound, Inter-
national (Input menu), Energy Saver, Date & Time, and Accounts 
(Fast User Switching). At the far right is the magnifying glass for 
the Spotlight menu, which isn’t really a status menu. 

Because status menus can come into being in various ways, there is 
no single way to remove them all. What you’d like to do, if you want 
to get rid of a status menu, is to reverse whatever it was that brought 
the status menu into being in the first place. But it is often far from 
obvious what that was.  
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PERFORM MISCELLANEOUS CONFIGURATIONS 

This section points out some miscellaneous customizations that you 
should not neglect in your eagerness to get on with using Leopard. 
These customizations are not less important than those that have 
preceded; I’ve collected them here because they couldn’t be catego-
rized into an earlier section. 

Set Up Login Items 
Your login items are applications that launch automatically when you 
log in to your user account. These are typically applications that you 
like to be always active; because of Mac OS X’s virtual memory model 
and non-polling event loop architecture, there is usually no penalty 
for having numerous applications running, except that when you start 
up your Mac, you must wait for them to all launch before you can get 
much done. 

To set up applications as login items: 

1. Open the Accounts preference pane. 

2. Select your user name in the list on the left, and click the Login 
Items button to show the Login Items view. 

3. Locate a desired application in the Finder and drag it from the 
Finder into the Login Items list. Or, click the  button and 
navigate to the application in the Open dialog. 

  
TIP You can make any application in the Dock a login item, without 

using the Accounts preference pane. To do so, Control-click the 
application’s Dock icon and choose Open at Login from the pop-
up menu. 

  

Limit User Powers 
If you’re the administrator of a Mac with multiple users, and you want 
to restrict the abilities of certain users beyond what permissions alone 
can achieve, you’re in luck: new in Leopard is the Parental Controls 
preference pane. This feature has come a long way from the simple-
minded, inflexible “No Limits/Some Limits/Simple Finder” of earlier 
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FIND OTHER CUSTOMIZATIONS 

On the one hand, a systematic discussion of every pane of System 
Preferences, and every option in every application’s Preferences 
window, one by one, would bore most readers to tears. On the other 
hand, you can (and should) make important customizations in these 
locations. So here’s a compromise—a final word of advice.  

Here it is: 

  
FINAL 

ADVICE 
This book has pointed out Leopard customizations that are 
particularly important or difficult to find, but many other cus-
tomizations remain, and you should still search out those other 
customizations and tweak Leopard so that it’s the way you like 
it. For example, this book hasn’t talked about setting your 
computer’s sound volume, or specifying its Beep sound.  
So take some time, after the excitement of meeting Leopard 
has subsided, to march through every view of every pane of 
System Preferences. Look at your options, and make sure 
things are set up the way you like them.  
Similarly, as you start up an application, take a moment to 
examine its preferences and see what customizations are 
available to you. For example, in Safari, do you like tabbed 
browsing? When you click a link to open a page in a new tab, 
do you want holding the Shift key to mean “open the page in 
the background” or “open the page and switch to that tab right 
now”? This book hasn’t talked about how you set up Safari’s 
preferences. But those are still things you should do. 
Finally, if you think a particularly important customization has 
been omitted from this book, email us and let us know. Maybe 
we’ll include it in a future update. Many of our ideas about what 
customizations our readers find significant have come from our 
readers themselves. 
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APPENDIX A: USE APPLESCRIPT TO MAKE EVERY 
WINDOW OPEN IN LIST VIEW, NO MATTER WHAT 

There are some disappointing limits on how far you can readily cus-
tomize Finder windows. For example, if you prefer List view, you can 
set the default Finder window (the one that appears when you press 
Command-N) to be in List view; but you cannot specify that you want 
every Finder window you ever open to be in List view. 

For example, suppose in the Finder, with no windows open, you 
choose Go > Utilities. This move doesn’t involve a default Finder 
window, so all bets are off as to what view this window will use. Of 
course, you can now change the Utilities folder window to List view 
if that’s what you prefer. But you’ve fixed the problem for only one 
window; the next time you open a folder in a separate window, the 
problem recurs. 

Here’s the upshot: To guarantee that every window you open from 
now on will be in List view, you would have to open every window 
of every folder on your Mac and set it to List view!  

Sounds prohibitively tedious, doesn’t it? On the other hand, this is 
a computer, after all, and the point of having a computer is to make 
it do the tedious stuff for you. This is why Apple has provided a script-
ing language that can make applications perform repetitive or tedious 
actions automatically—AppleScript. With AppleScript, you can write 
a program, called a script, and execute it. The script can tell an 
application—in this case, the Finder—to do the same kinds of thing 
you would normally make it do by manipulating the mouse and key-
board. The difference is that you don’t use the mouse and keyboard; 
you don’t do anything! The script is faster and more accurate than 
you would be, operating manually, and the computer doesn’t get bored 
or tired at doing the same thing over and over (or at least, if it does, 
it doesn’t complain).  

So here’s a script that does automatically the very same thing you’d 
have to do manually in order to set all your folder windows to List 
view. It starts with a folder, and looks at all the folders inside that 
folder. It opens each of those folders and sets its window to List view,  
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ABOUT THIS BOOK 

Thank you for purchasing this Take Control ebook. We hope you find 
it both useful and enjoyable to read. We welcome your feedback; click 
Feedback on the cover. Keep reading in this section to learn more 
about the author, the Take Control series, and the publisher. 

About the Author 
Matt Neuburg is a former Classics 
professor. One of his students, to whom 
he tried to teach the fine art of composing 
Greek sentences, was Adam Engst, who 
later went on to publish TidBITS. Matt 
eventually left academe and became a 
TidBITS Contributing Editor, writing 
reviews of software such as outliners 
and databases.  

Matt is also a consultant, documentation writer, and programmer; 
his popular freeware utilities include MemoryStick and NotLight. He 
has written three books for O’Reilly Media: Frontier: The Definitive 
Guide, REALbasic: The Definitive Guide, and AppleScript: The 
Definitive Guide. He lives in the village of Ojai, California, which 
he regards as all but indistinguishable from Paradise. You can find 
Matt’s home page at http://www.tidbits.com/matt/. 

Author’s Acknowledgements 
This book is dedicated to sun and sand, which provided rest and 
relaxation at just the right moment.  

Shameless Plug 
One extremely powerful way to customize your 
Macintosh is with AppleScript, a system-level language 
that can make applications do things programmatically. 
Instead of your doing something with the mouse, then 
reading the screen, then thinking about what you 
should do next, and so forth, the Mac does the doing, 
the reading, and the thinking. This means that your 
hands and eyes and brain are freed from having to 
perform repetitive or tiresome activities better suited to a computer. 
Lengthy operations can be reduced to a single step, and applications 
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can be made to work together. You can also use AppleScript to 
customize such things as what happens when a file is placed into 
a certain folder in the Finder, or what your Mac does when a music 
CD is inserted.  

For the full story you might wish to obtain my book, AppleScript: 
The Definitive Guide (second edition), from O’Reilly Media 
(http://www.oreilly.com/catalog/applescpttdg2/). 

About the Publisher 
Publishers Adam and Tonya Engst have been 
creating Mac-related content since they started 
the online newsletter TidBITS, in 1990. In 
TidBITS, you can find the latest Macintosh 
news, plus read reviews, opinions, and 
more (http://www.tidbits.com/). 

Adam and Tonya are known in the Mac  
world as writers, editors, and speakers. 
They are also parents to Tristan, who 
thinks ebooks about clipper ships and 
castles would be cool. 
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